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1 Introduction

NetSim satellite library models end-to-end, full stack, packet level communication between
terrestrial nodes and Geostationary satellites. Geo satellites have the unique property of
remaining permanently fixed in exactly the same position in the sky as viewed from any fixed
location on Earth. This means ground-based antennas do not need to track them but can
remain fixed in one direction. These satellites have orbital period that is the same as Earth’s

rotation period and are the most common type of communications satellites.

The Satellite MAC layer protocol supported in NetSim is TDMA for forward link and MF-TDMA
for return link (based on the DVB S2 standards). The forward link is in the Ku band (12 — 18
GHz) while the return link is in the Ka band (24 — 40 GHz)

The satellite can be thought of as a relay station. It operates on the bent-pipe (transparent
star) principle, sending back to Earth what comes in, with only amplification and a shift from

uplink to downlink frequency.

In NetSim, the satellite communication network library interfaces with Internetworks library.
This means users can connect Satellite gateway and User Terminals to devices such as

Routers, Switches Wired nodes, Access point and Wireless nodes etc.
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Figure 1-1: NetSim GUI showing Satellite User Terminals connected to a server via satellite links
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Figure 1-2: The Result dashboard and Plot window shown in NetSim after completion of simulation

The PHY layer models include:

a. Channel model: Friis free space path loss with Loo Markov fading model.
b. Modulation: QPSK, 8PSK, 16APSK, 16QAM, 32APSK with appropriate coding rates.
c. Tx, Rx Antenna gains.

d. Antenna gain to noise temperature.
All the choices of transport protocols, and all types of applications in unicast mode can be run.

NetSim’s protocol source C code shipped along with (standard / pro versions) is modular and

customizable to help researchers to design and test their own sat-com protocols.
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2 Simulation GUI

Open NetSim, Go to New Simulation > Satellite Comm. Networks

NetSim Standard

Network Simulation/Emulation Platform

Version 13.1.19 (64 Bit)

Choose a Network

New Simulation Ctl+N @il Intemetworks (Base) @ Legacy Networks & Mobile Adhoc Network ! Wireless Sensor Networks
Vour Work Culso  Features TCP, IP, Routing, Wi-Fi, Ethemet, RF Features Pure Aloha, Slotted Aloha, GSM and Features DSR, AODV, OLSR and ZRP routing Based on 802154 MAC/PHY interfaces with
Propagation, Application Models, Network Stack, CDMA. Legacy Networks run standalone and do protocols, and multiple MANETs with bridge MANET library
Examples Simulation Kernel, Animator and Plot Engine not interface with Internetworks ibrary nodes. MANETs interface with Internetworks
library
Experiments
8 Licensed 8 Licensed 8 Licensed
& Internet of Things @l Cognitive Radio Networks @ LTE/LTE-A @ Vehicular Adhoc Networks
Features WSN, RPL and 6LOWPAN with MANET Based on 80222 standard and interfaces with Based on 3GPP 36 series standards. LTE/LTE-A Based on IEEE1609 Wave and IEEEB02.11p with
fouting. loT interfaces with Intemetworks and Internetworks library interfaces with Internetworks library MANET  routing. VANETs interface  with
MANETS libraries Internetworks library and SUMO
8 Licensed 8 Licensed 8 Licensed 8 Licensed
@0 56 NR @i Satellite Comm. Networks
Based on 3GPP 38 series standards. SG NR Features Geo stationary satellite, TOMA in Ku
interfaces with Internetworks library 8and and MF-TDMA in Ka Band per DVB S2
Interfaces with Internetworks library
License Settings
Exit AltsF4 @ Licensed @ Licensed
@ Advanced Routing [l Software Defined Networks Add-on Network Emulator
Features VLAN, Multicast Routing: IGMP and PIM, Based on Openflow protocol. Access this feature Connect real systems running live applications to
L3 Switch, ACL and NAT. Access these features within the properties of all L3 devices. SDN NetSim. Interfaces with all components except C2
within the properties of Switches and Routers interfaces with all components except C2 and and C7. Access this feature inside Application
available in C1 cn properties.
Current workspace: Workspace_1
Support Learn Documentation Contact Us

Email - sales@tetcos.com
Phone - +91 767 605 4321
Website :

Figure 2-1: NetSim Home Screen

2.1 Create Scenario

Satellite Communication Networks palette features various devices like Wired Nodes, L2
Switch, Access Point, Wireless node, UT Router (User Terminal Router), Router, UT Node

(User Terminal Node), Satellite Gateway, and Satellite.
2.2 Devices specific to NetSim Satellite Comm. Library

a. UT - User Terminal. The user terminals are part of the same communication network as
the Satellite Gateway. The User Terminals in NetSim are UT_Node and UT_Router

b. UT Router - User Terminal Router. A UT _Router is used when a separate
communication network is required. The typical use case is where there are multiple
devices downstream who seek to utilize the sat-com link. The UT Router cannot be a
source of any traffic.

c. Satellite Gateway: Each gateway has two interfaces, a satellite interface and multiple
wired interfaces. The satellite interface connects via the forward link to the satellite. The
wired interface allows for connection to routers via the wired interface. When connected
to a satellite, the user terminals mapped to the gateway are part of the same network.
Multiple gateways can be configured per satellite, and round-robin scheduling is run (at

the Network control center (NCC) which is not displayed in NetSim GUI)
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2.3

. Satellite: Since the satellite model is a bent pipe the satellite does not have an IP. Each

satellite can be connected to multiple gateways and to multiple User_Terminals. The
satellite node cannot be the source of any traffic. The default altitude of the Satellite is
35,768,000 meters, which represents the circular geosynchronous orbit. Multiple
satellites can be configured per scenario. However, no interference is modeled when
multiple satellite communication occurs simultaneously.

Coordinate System: NetSim uses a Geodetic co-ordinate system. The altitude is from
Mean Seal level. The geocentric co-ordinate system uses distance from the centre of
the earth.

Mode L2 Devices Router Sat_Gateway User_Terminal Satellite

Figure 2-2: The devices present in the ribbon in NetSim’s GUI
Placement of devices on the grid environment

Add a User Terminal (UT) — Click the User_Terminal > UT_Node icon on the toolbar
and place the device in the grid. UT_Node must be connected to Satellite.

Add a UT Router — Click the User_Terminal > UT_Router icon on the toolbar and place
the device in the grid. UT_Router must be connected to a Node or to a L2_Switch or to
a Router or to an Access_Point or Satellite.

Add a Satellite — Click the Satellite icon on the toolbar and place the Satellite in the grid.

Satellite must be connected to a Satellite_Gateway or to a UT_Node or to a UT_Router.

. Add a Satellite_Gateway — Click the Satellite_Gateway icon on the toolbar and place

the Satellite_Gateway in the grid. Satellite_Gateway must be connected to a Satellite or
to a Router.

Add a Router — Click the Router icon on the toolbar and place the Router in the grid.

f. Add a Wired Node — Click the Wired_Node icon on the toolbar and place the device in

the grid.

. Add a L2_Switch — Click the L2_Switch icon on the toolbar and place the device in the

grid.

. Add an Access Point — Click the Access_Point icon on the toolbar and place the

Access_Point in the grid.
Add a Wireless Node — Click the Wireless Node icon on the toolbar and place the device

in the grid.
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Note: It is recommended not to connect multiple satellite gateways to a single satellite since

this can leads to IP address and static route complications

2.4 GUI Configuration Parameters

The SATELLITE parameters can be accessed by right clicking on a Satellite, Satellite
Gateway, UT Router or UT and selecting Interface (SATELLITE) Properties > Datalink and
Physical Layers.

Satellite Properties

Interface (Satellite) — Physical Layer
| Parameter ______ Type _ |Range __ |Description
Antenna gain-to-noise-
temperature is (G/T) where G is
the antenna gain in decibels at the
receive frequency, and T is the
equivalent noise temperature of
the receiving system in kelvins.
It is the signal intensity of the
transmitter. The higher the power
Tx Power Local 0-10000dBW radiated by the transmitter's
antenna the greater the reliability
of the communications system.
TDMA allows a number of clients
to access a single radio-frequency
channel without interference by
TDMA allocating unliqt.Je time slots to
each user within each channel,
reducing the loss of packets and
Access Protocol improving the data rate thereby
delivering QoS to the clients.
Multi-frequency time-division
multiple access is a technology for
Fixed MF-TDMA dynamically sharing bandwidth
resources in an over-the-air two-
way communications network.
The “band” in use refers to the
radio frequencies used to and
from the satellite:

G/T (dBk) Local 0-100000dBk

Fixed

Ku-band: 12-

Rz Ku-band services uses the 12 - 18

Base Frequency (GHz) Local GHz, and

Ka-band: 26-

iRz Ka-band services uses the 26- 40

GHz segment of the
electromagnetic spectrum
Microwave frequency band used
for satellite communication and
broadcasting, using frequencies
in the range of 12 -18 GHz
Microwave frequency band used
for satellite communication and
broadcasting, using frequencies
in the range of 26 - 40 GHz
Rolloff Factor Local 0-1 In NetSim,

Fixed KU
Band

Fixed KA
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Spacing Factor

Carrier Bandwidth (Hz)
Framecount in Superframe
Frame Bandwidth (Hz)

Frame Usage Mode

Modulation

Coding Rate

Slot Count in Frame

Symbol Rate

Symbol per Slot

Pilot Block Size (Symbols)
Pilot Block Interval (Slots)

Pilot Header (Slots)

Frame Header Length
(Bytes)

BER Model

Ver 13.1

Local

Local
Local
Local

Local

Local

Local

Local

Local

Local

Local

Local

Local

Local

Local

0-1000000 Hz
0-1000000

0-1000000 Hz
NORMAL
SHORT
QPSK

8PSK
16APSK
16QAM
32APSK

1/3,1/2, 3/5, 2/3,
3/4, 4/5, 5/6, 8/9,
9/10

Short Frame:
QPSK-90, 8PSK-
60,
16APSK/16QAM-
45,

32APSK-36
Normal Frame:
QPSK-360,
8PSK-240,
16APSK/16QAM-
180,
32APSK-144

0-1000000
0-1000000

0-1000000
symbols

0-1000000 slots
0-1000000 slots
0-1000000 bytes

Fixed

FILE BASED

Page 9 of 35

Symbol Rate = BW / (1+Roll of
factor) and

Bit Rate = Symbol rate *
Modulation order * CodeRate

In  NetSim EffectiveBandwidth
(Hz) = AllocatedBandwidth (Hz) /
((RollOffFactor + 1.0) *
(SpacingFactor + 1.0));

Spacing factor should be in the
range of [0,1]

Bandwidth of the carrier in Hz
Number of frames present in a
superframe.

Bandwidth of the frame in Hz.

Baseband frame usage modes.

Modulation is the process of
varying one waveform in relation
to another waveform. It is used to
transfer data over an analog
channel.

It states what portion of the total
amount of information that is
useful(non-redundant). This code
rate typically a fractional number.

The number of slots per frame.
The number of slots per frame is
based on modulation and frame
type chosen.

It is ratio of total bandwidth and
(1+ Roll of Factor)

The number of TDMA symbols
within a slot, the default value of
symbol per slot is 90.

Size of pilot block in symbols

Interval (in symbols) between
Pilot blocks

The pilot block header size in
slots.

Baseband frame header length in
bytes

BER value is based on the user
input.

File Based is a feature in NetSim
with which users can define the
BER. Users will have to provide a
BER_FILE.ixt file as input to
NetSim by clicking on the Open



file link the Physical Layer-
Properties of the device.

The BER model, calculates the

MODEL BASED BER via the pathlo_ss model for
— the particular scenario.

This is the rate at which errors

occur in the transmission of digital

BER Local 0.00000001-1
data.

UT Properties
Interface (Satellite) — Physical Layer

Parameter
A relative measure of an
antenna’s ability to direct or

Tx Antenna Gain (dB) Local 0-1000000dB concentrate  radio  frequency
energy in a particular direction or
pattern at the transmitter side.

A relative measure of an
antenna’s ability to receive radio

Rx Antenna Gain (dB) Local 0-1000000dB frequency energy in a particular
direction or pattern at the receiver
side.

Table 2-1: Satellite, Satellite Gateway, UT Router or UT and selecting Interface (SATELLITE)
Properties > Datalink and Physical Layers Description
Propagation Model

Link Properties

Parameter ‘Type | Range | Description

Medium of propagation in NetSim
would be Air for RF waves.

Path loss and fading and
shadowing: In pathloss models,
for a fixed distance between
source and destination, path loss
is same. We get varied path loss
for some distance between

Propagation Medium Link Air

Pathloss and

Channel Characteristics Fixed Fading and L .
. source and destination in
Shadowing . S L
shadowing and fading is variation
of the attenuation of a signal with
various variables. These variables
include time, geographical
position, and radio frequency.
Shadowing Model Fixed NONE

It Used to model the LOS path
loss incurred in the channel. the
Pathloss Model Link Friis Free Space Frus. B
restricted to unobstructed clear
path between the transmitter and
the receiver.
Path loss exponent indicates the
rate at which the path loss
Pathloss Exponent (n) Fixed 2 increases with distance. The
value depends on the specific
propagation environment.
Each state of the three-state

el e e ey LeD Markov channel models obeys the
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Loo distribution with different
parameters; while the state
transition is modeled as a first-
order Markov random process.
Mean value of the direct signal,
Direct Signal Mean (dB) Link -0 tQ value can be differentiated
according to the state.
Standard Deviation of the direct

Dfiveres gl Sk e Link Oto signal value can be differentiated

(el according to the state.
RMS squared multipath power in
RMS Multipath Power (dB) | Link -0 tQ dB

Number of direct signal oscillator

Number of Direct Signal is used for frequency conversion

Link Oto

Oscillators process in  superheterodyne

receiver.
. Number of multipath oscillators is
gun]ber of Multipath Link Oto used to generate higher
scillators — !

oscillation frequencies.

Direct Signal Doppler (Hz) Link 0to =
The normalized PSD (its integral
in the whole frequency range
equals to one) constitutes the

Multipath Doppler (Hz) Link 0to PDF for the Doppler frequencies,

arising from the different angles of

arrival the multipath components

have with respect to the receiver’s

motion.

An initial probability distribution,

defined on S, specifies the starting

Initial Probability Link Oto1 state. Usually this is done by
specifying a particular state as the
starting state.

Table 2-2: Propagation Model/Wireless Link Properties Description

2.4.1 Mapping of User_Terminal (UT_Note / UT_Router) to Satellite_Gateway

Each satellite can be connected to multiple Satellte Gateways and to Multiple
User_Terminals. The following screen shot shows how to map the User_Terminal to

Satellite_Gateway as shown Figure 2-3.
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Figure 2-3: Mapping of User_Terminal (UT_Note / UT_Router) to Satellite_Gateway
In order to Map User_Terminal (UT_Node / UT_Router) to Satellite_Gateway right click go to
the properties of UT_Node/lUT_Router > INTERFACE1_(SATELLITE) -
DATALINK_LAYER > Gateway user can map the Satellite_Gateway with UT_Node /
UT_Router accordingly.

Additionally, in the UT_Router/UT_Node -> Interface_Satellite the default gateway IP should

be set as the IP of the connected Satellite_Gateway.

Incorrect mapping of the Satellite_Gateway and/or the default Gateway IP address, in the
properties of the UT_Node / UT_Router could lead application crash or NIL application
throughputs.

2.4.2 Configuring Static Routes

After mapping the UT_Router/UT_Node to a Satellite_Gateway, static routes need to be
configured in the devices to forward traffic. Let us consider the following network scenario as

shown Figure 2-4.
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Figure 2-4: Network Topology in this experiment
In this network scenario, for UDP traffic to be sent from UT_Node 2 to UT_Node 3, static

routes need to be set in UT_Node_2 and in the Satellite_Gateway 4.

If TCP traffic needs to be sent from UT_Node 2 to UT_Node_3, then static routes need to be
set in UT_Node_3 as well. This is essential for connection establishment and sending

acknowledgements.

Refer the featured example on Configuring applications from UT Node to UT Node for detailed

information on static route configuration.
2.4.3 Multiple gateways connected to a single satellite

An example where Multiple gateways are connected to the single Satellite is shown in below

screenshot Figure 2-5.
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Figure 2-5: Network Topology for this experiment. The red arrows indicate packet flow. The satellite is
at an atlitude ~ 35,000 kms and hence should be imagined as being at this height.
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In order to Map User_Terminal (UT_Node / UT_Router) to Satellite_Gateway, right click
/properties of UT_Node/UT_Router > INTERFACE1_(SATELLITE) > DATALINK_LAYER
- Gateway. Here the user must map the Satellite_Gateway? for the UT_Node / UT_Router.
For UT_Node_6, the satellite gateway is 3, and for UT_Node_5 the Satellite gateway is 2.

In this network scenario, for UDP traffic is sent from UT_Node 5 to UT_Node 6. The traffic
flow is UT_Node_5 > Satellite_1 > Sat_Gateway_2 > Router_4 > Sat_Gateway_3 > Satellite_1
> UT_Node 6. Appropriate static routes need to be configured in UT_Node 5,
Sat_Gateway_2, Router_4, and Sat_Gateway_3.

Refer the featured example on Configuring applications from UT Node to UT Node for detailed

information on static route configuration.

1 Default Gateway IP address is an IP layer address configuration, and is different from Satellite Gateway which is a device
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3 Model Features

3.1 TDMA Forward Link and MF TDMA Return Link
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Figure 3-1: Forward and Return links. The Network Control Centre (NCC) is not displayed in NetSim
and is assumed to be part of every satellite

In NetSim, a Forward link is defined as the direction from Satellite Gateway to Satellite to
UT_Node /UT_Router. A Return link is defined as the direction from the UT_Node / UT_Router
to Satellite to the Satellite Gateway.

The protocol operating in the Forward link is Time Division Multiple Access (TDMA). The
protocol operating in the Return link is Multi Frequency Time Devision Multiple Access (MF-
TDMA).

Both the Forward link and Return link transmissions in NetSim are modeled as Layer-2

transmissions. The framing is as explained in the subsequent paragraph.

Each Super Frame is composed of a number of Frames. This is taken as a user input, given
by the attribute Framecount_in_SuperFrame available in Satellite -> Interface_Satellite ->
Physical_Layer properties. The frames in turn are composed of carriers (in frequency) and

slots (in symbols). The number of carriers would be

Frame Bandwidth (Hz)
Carrier Bandwidth (Hz)

Number of Carriers =

The number of slots per frame is determined by the modulation scheme chosen by the user.
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3.2 Modulation and coding schemes supported

QPSK with coding rates 1/3, 1/2, 3/5, 2/3, 3/4, 4/5, 5/6, 8/9, 9/10
8PSK with coding rates 3/5, 2/3, 3/4, 5/6, 8/9, 9/10

16APSK with coding rates 2/3, 3/4, 4/5, 5/6, 8/9, 9/10

16QAM with coding rates 3/4, 5/6

32APSK with coding rates 3/4, 4/5, 5/6, 8/9

o &~ N =

3.3 Physical layer framing for forward and return links

FRAME
S slots
b 90 symbols >
Slot-1 Slot-2 S Slot-5
1 slot (/28PSK)_ 16 slots (selected moaul\ation) 3
<
PLHEADER Slot-1 Slot-.._ .. Slot-16 iz Slot-5
block .
4+—>
For modes unmodulated
SOF PLSCODE requiring pilots carriers
< >
PLFRAME before PL Scrambling 90(S+1)+P int{(5-1)16}  (P=36 pilots)

Figure 3-2: Format of a “Physical Layer Frame” PLFRAME

Nidpe = 64800 1 =16200
(normal frame) (short frame)

Nmop (bits S 1 % no S | 1% no — pilot
/HZz) — pilot

2 360 99.72 90 98.90

3 240 99.59 60 98.36

4 180 99.45 45 97.83

5 144 99.31 36 97.30

Table 3-1: S = number of SLOTs per FRAME (number of symbols per slot is 90)
The normal frame and short frame setting can be done using the Frame_Usage Mode
parameter in the GUI as shown Figure 3-3.

Changing the Modulation scheme in Ul would change the value of S (Slot_count_in_frame)
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o Satellite a x
Satellite » DATALINE_LAYER
¥ PHYSICAL_LAYER
GENERAL FORWARD
Access Protocol TDMA
TRANSPORT_LAYER
Base_Frequency (GHz) 12
INTERFACE_1 (SATELLITE)
Band KU
Ralloff_Factor 10
Spacing_Factor 1.0
Carrier_Bandwadth (Hz) . 10000000
Framecount_In_Superframe . 10
Frame_Bandwadth (Hz) 10000000
I Frame_Usage_Maode MORMAL - ]
Muodulation . QPSK d .
Coding_Rate . 12 -
I Slot_Count_in_Frame 360 I
Symbol_Rate 1000000
Symbal_per_Slot o0
0K Resst

Figure 3-3: Satelittle > Physical layer properties window
Default NetSim GUI settings

= Symbols per slot: 90

= Pilot Block size (symbols): 36

= Pilot block interval (slots): 16

= PL header size (slots): 1

= Frame header size (In bytes): 10 (per ETSI EN 302 307 V1.3.1)

*» Frame Type: Normal (Options are normal or short)
3.4 Satellite PHY: Data Rate

Given below is the data rate calculation methodology for both forward and return links. The

parameter values used are the default values in NetSim GUI.

BW
(1 + (Roll of factor))

Symbol Rate =

Bit Rate = Symbol rate X Modulation order X CodeRate
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Bandwidth (Hz) = Frame_Bandwidth (Hz) = 10° Hz

Bandwidth (Hz)
2.0

Central Frequency (Hz) = Base Frequency (Hz) +

10
Central Frequency (Hz) = 26 x 10° + - = 26000500000 Hz

Carrier Bandwidth (Hz)
(RollOfFactor + 1.0) x (SpacingFactor + 1.0)

Effective Bandwidth (Hz) =

10° 25x 10* H
=25 X
(1.0 + 1.0) x (1.0 + 1.0) z

Effective Bandwidth (Hz) =

Symbol Rate = Ef fective Bandwidth (Hz) = 25 X 10*Hz
Modulation Bits = 2

The number of Modulation Bits depends on the modulation scheme per the table below:

Modulation Modulation bits

QPSK 2
8PSK 3
16APSK/16QAM 4
32APSK 5

Table 3-2: Modulation bits for different modulation

Slots = Slot Count in Frame + Pilot Header (slots) = 360 + 1 = 361

Data Symbols = Slots X Symbol per Slot = 361 X 90 = 32490

Slots 361

Pilot Block Interval - 16 =22

Pilot Slot =

Pilot Symbol = Pilot Slot X Pilot block Size (symbols) = 22 X 36 = 792 Symbols

Total Symbol = Pilot Symbol + Data Symbols = 792 4+ 32490 = 33282

Frame length = =250l 1 000000 = —2222 & 1000000 = 133128
= X = X =
rame length = o) mbol Rate 250000 Hs
Pilot Block Length = -0t Plock Stze 1 000000 1000000 = 144
= X = X =
Hot Stoci Leng Symbol Rate 250000 Hs
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Slot Length = SYmbotper Slot - 010000 =
OF LG = T o mbol Rate =~ 250000

X 1000000 = 360 us

SuperFrame Duration = Frame length X Frames per SuperFrame = 133128 x 10

= 1331280 us
1
Bits per Slot = Symbol per slot X Modulation Bits X Coding Rate = 90 X 2 X 5= 90

Bits per Frame = Bits per Slot X Slot Count in Frame = 90 x 360 = 32400

Bits per Slot 90 bits
Slot Length ~ 360 us

Data Rate = = 0.25 X 10° bits/sec = 0.25 Mbps

3.5 Analytical throughput estimation

Let us an example in which the Packet Size (App layer) is 1460B which translates to 1488B at
the PHY layer after addition of overheads, with QPSK modulation and % coding rate. For this

modulation and coding rate the raw PhyRate of the channel is 162249 bps using the formulas

given in 3.4. The analytical throughput estimate for such a scenario would be:

PacketSize(at PHY) X8 1488 x 8

PacketTransmissionTime = = 0.0733687s = 73368.7us

PhyRate(bps) 162249
PacketsPerF _ FrameTime _ 133128 — 1181l =1
acketsfertrame = lPacketTransmissionTimeJ B l73368.7J = 11.81] =

PacketsPerFrame is the number of packets that can be packed in a frame, and hence the

greatest integer or floor function is used.
BytesPerFrame = PacketsPerFrame X PacketSize(B) = 1488 x 1 = 1488

1
Frame Duration(s) 0.133128

NumberOfFramesPerSecond = =7.51

PhyThroughput = NumberOfFramesPerSecond X (BytesPerFrame X 8)
= 7.51 X (1488 x 8) = 89399.04 bps = 0.089 Mbps

1460
ApplicationThroughput = 1488 X PhyThroughput = 0.087 Mbps

3.6 PHY rate for various modulations and coding rates

Modulation Slot Count in a PHY Rate

Modulation bits frame Ciealing iz (Mbps)
QPSK 2 360 13 0.167
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1/2 0.250

3/5 0.300
2/3 0.333
3/4 0.375
4/5 0.400
5/6 0.417
8/9 0.444
9/10 0.450
3/5 0.450
2/3 0.500
3/4 0.561
8PSK 3 240 5/6 0625
8/9 0.667
9/10 0.675
2/3 0.667
3/4 0.750
4/5 0.800
16APSK 4 180 5/6 0833
8/9 0.889
9/10 0.900
3/4 0.750
16QAM 4 180 5/6 0833
3/4 0.936
4/5 1.000
32APSK 5 144 5/6 1.042
8/9 1.111

Table 3-3: List of support modulation schemes and coding rates, and their respective PHY Rates

3.7 Satellite PHY: Land Satellite Channel Model

3.7.1 Propagation

The distance between the ground nodes and the satellite determines the propagation delay
and path loss of the radio signal. The distance is computed based on the cartesian distance
between the ground nodes and the satellite. NetSim computes the propagation delay of the
radio signal traveling from the source node to the destination node at the speed of light. The
propagation model calculates the weakening of the radio signal as it propagates from the
source node per the pathloss and fading model.

3.7.2 Pathloss Model — Friis Free Space Propagation

The free space propagation model is used to predict received signal strength when the
transmitter and receiver have a clear, unobstructed line-of-sight path between them. Satellite
communication systems and microwave line-of-sight radio links typically undergo free space
propagation. The free space power received by a receiver antenna which is separated from a

radiating transmitter antenna by distance d, is given by the Friis free space equation.

P. = P+ G+ G, + 20logqo]

A + (1021 do
_— * * —_
(4*7T*d0)] ( Oglo(d))
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where P;is the transmitted power.
PB. is the received power.
G; is the transmitter antenna gain.
G, is the receiver antenna gain.
d is the T-R separation distance in meters.
A is the wavelength in meters.
3.7.3 Fading model
NetSim uses a 3 state (state 1, state 2 and state 3) Markov model to simulate fading.

The conditional probabilities of state s,,,.; given the state s,are described by state transition

probabilities p;;

Where §;, S,, S3 denotes respective channel state, P;; is the probability the Markov process

goes from state i to state j.

Figure 3-4: Switching of three-state Markov process

The switching among each state is described by a transition metrix P, which is

P11 P12 P13
P = P21 P22 P23

P31 P32 P33

Each state of the three-states of the Markov model obeys the Loo distribution with different

parameters, while the state transition is modeled as a first-order Markov random process.

The Loo distribution considers the received signal as a sum of two signal components. A log-
normally distributed direct signal expresses the slow fading component corresponding to
varying shadowing conditions of the direct signal. A Rice distribution characterizes the fast-

fading component due to multipath effects.

The Loo parameter triplet consists of the mean, the standard deviation for the log-normally

distributed direct signal, and the average multipath power.
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N(u,0%) +R

Depending on the current state interval and on the environment of the terminal, a new random
Loo parameter triplet is generated. The output of the channel model is a time-series of the

received signal in form of a complex envelope.

And finally, the model computes the Loo distributed time-series including Doppler shaping for

every new state interval, which is the output of the proposed LMS channel model.

Sate sequence generator (550:) Propagation parameter generator (PPG)
Vipy o)
| o M
Hy = D6y B Gs) | HQ -
M,
Paur+ O dos Ny, 04)
py = UMy a0y, 03,a5) ™ =
| 0y = f(My,ay,ay,a) Zo) N
Semni- Markov
model | : Ny, 05)
. State (good/bad) /——.\ MP
State duration (D) -} |
N
Small-scale fading generator (SSFG) ‘Illu'..u‘_ ]
Tpp
‘- (0, ]] Butterworth filter 12
K ,) -||1 J[ (Doppler shift of all
i Normalization \.gnﬁ components)
¥ n'_'l"'""' {(u=0+0j, ‘(:)— ofon
IU 1) i /' filter o=14+0j)
_r /_l Complex
envelope
410, 1) Rat
ate P .
f_)_”..n“—r-.i-rnand L) Normalization H{’)_( \—h ol | & /_\
L\_ interpolation e=0o=1)
i I
Ly Ly M, " (Do pplu shift
of direct component)

Figure 3-5: The Satellite LMS channel Model
3.7.4 SNR - BER Calculation

Received power (in mW))

SNR (dBm) = loguo ( Thermal Noise (in mW)

The SNR is calculated separately for each ‘hop’ of each link. This means the calculation is

done from Gateway to Satellite and then separately again from Satellite to UT, and vice versa.
Noise = ki T B where kgis the Boltzman’s constant, B is the carrier bandwidth and T is the
temperature calculated per user input of%(dBK) in NetSim UL

NetSim provides three options for BER.

= Model Based: The BER is then calculated for each link based on the SNR. Please see

Propagation-Models.pdf document for detailed information on BER calculation.
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e Fixed: the BER value can be input in the GUI. If this option is chosen, the SNR (derived
from propagation model) is not used.

e File Based: SNR — BER table should be provided in a file per the format given below.
This table should be in increasing order of SNR. The SNR is calculated by NetSim from
the RF propagation model. For this SNR, the appropriate BER is selected from this table.
BER is 1.0 for any SNR value below SNR1, and BER is 0.0 for any SNR greater than

SNRn.
SNR1, BER1
SNR2, BER2

SNRn, BERn

3.8 Results

Please see NetSim User manual, Results and Analysis section.

3.8.1 Satellite Log File

A log file specific to satellite communication, is generated post simulation as shown in screen

shot below,

[ Simulation Results - o X

Link_Metrics r
N Application_Metrics Detailed View = TCP_Metrics Detailed View
Queue_Metrics
Application Id  Throughput Plot Application Name  Packet generated  Packet receivex Source Destination ~ Segment Sent  Segment Received  Ack Sent  Ack Receive:
TCP_Metrics
= 1 Application Throughput plot  App1 CER 5000 1488 UT_NODE 2 ANY_DEVICE 0 0 0
1P_Metric:
AR UT_NODE 0
1P_Forwarding_Table SATELLITE GATEWAY.4  ANY_DEVICE 0
UDP Metrics

Application_Metrics

Plots
Link_Throughput
Application_Throughput

ot s B

Link_Metrics Detailed View | Queue_Metrics Detailed View

Export Results (.xis/.csv) Packet_transmitt.. Packet errored  Packet_collided Device_id Part_id Queued_pa.. Dequeued_. Dropped_p..
P Linkid  Link_throughput plot

Print Results (.html) Data Control Data Control Data Control

Al NA 5972 0 0 0 0
Open Packet Trace

Link_throughput 5972 0 0 0
Open Event Trace
Log Files
No content in table

ospflog

ospf_Hello.log

sateliiteJog

Restore To Original View

Figure 3-6: Result Window

On opening it would look like the image below
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| satellite.log - Notepad
Eile Eds E. ot WS Hel,

Forming return superframe for satellite 1-1.
Frame length = 133128.000800 us
Pilot block length = 144.000000 us
Slot length = 360.000000 us
Superframe Duration = 1331280.000000 us
Bits per slot = 99
Bits per frame = 32480
Superframe duration = 1331280.000 us
Superframe bandwidth = 108002¢.000000 Hz
Central frquency = 26828500000.000000 Hz
Carrier count = 1
Forming carrier 1
Carrier Id = 1
carrier allocated badwidth = 1890680.000000 Hz
Central frequency = 26802580000.000808 Hz

Forming forward superframe for satellite 1-1.
Frame length = 133128.880000 us
Pilot block length = 144.800000 us
Slot length = 360.8000800 us
Superframe Duration = 1331230.0008000 us
Bits per slot = 99
Bits per frame = 324088
Superframe duration = 1331280.00@ us
Superframe bandwidth = 1880080.000000 Hz
Central frquency = 12000580000.000000 Hz
Carrier count = 1
Forming carrier 1
Carrier Id = 1
carrier allocated badwidth = 19900800.900000 Hz
Central frequency = 12000500000.000000 Hz

UT 2-1 is assoclated with gateway 4-1
UT 3-1 is associated with gateway 4-1
Satellite 1-1, Time 0.800 us
Resetting previous superframe
Starting new superframe
Superframe Id = 1
Superframe start time = 0,000 us

Figljre 3-7: NetSim Satellite communication Iog file

This file logs details such as

= UE - Satellite Gateway association
= Calculated Super frame, frame, slot, bandwidth, carrier count etc. for each satellite.

= Frame by frame transmissions with time stamps
3.8.2 Enable Propagation log

A Sat comm. propagation log file can be enabled by the user, in the file Satellite.h, by
uncommenting the line #define SATELLITE_PROPAGATION_LOG
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0Q Fle Bt View Projct Buld Debug Tt Anayie ook Eatemsions Window Help | bemrch(
- B-a BP9 Dbug - st - P Local Windows Debugger - | 4% | @
Sateliteh = x
! sanellite -] & enum_SATRLLITE DEVICE TYPE
1
32 sendif
33
34 f/For MSVC compiler. For GCC link via Linker command
35 agna comment(1lib, "Metrics.1ib")
36 agma comment (1ib, "NetworkStack.1ib")
37 #pragna comment(1ib,"Mobility.1ib")
8 #pragna comment(1ib,"PropagationModel.lib")
39
49 /06
41 #define SATELLITE_LOG
42 void print_satellite log(char* format, ...);
12 void satellite log add tab(};
aa void satellite_log remove tab();
a5
46 | // #define SATELLITE_PROPAGATION_LOG |
47
48 = typedef enum enum_SATELLITE_DEVICE_TYPE
as {
58 SATELLITE_DEVICETYPE_USER_TERMINAL,
s51 SATELLITE_DEVICETYPE_SATELLITE,
52 SATELLITE_DEVICETYPE_SATELLITE_GATEWAY,
53 SATELLITE_DEVICETYPE_UNKNOWN, //Keep me at last
54 }SATELLITE_DEVICETVPE;
static const char* strSATELLITE_DEVICETYPE[] =

Show output from:

5
© Mo lssues found

SUSER TERMTHAL® "SATENITTE® "SATEL| TTE GATELAY" “Iinknowm® -

Ldg  Chi3 CokE

BesdEH oS-

b

[
B Cellular

P Cllinterpretor
[ CogntveRadio
[ DSk

P
9 LIENR
8 Medium

b & Mobilty =

Selution Explorer

o

naiED

# Addto Saurce Ca

Figure 3-8: Enable Satellite Log file in Satellite Comm. Network

Then Rebuild the source codes of Satellite Project and run the simulation.

54 File Edt View Project Buld Debug Test Andbze Tools Extensi
OG-0 @ -2 B D | Debug - x4 ~ b Local

ons  Window  Help | Search (Cirl+Q)

Windows Debugger = | 5 | @]

D - x

& LiveShare &7

Figure 3-9:

L satelliteh = % Ml Solution Explorer ~rx
é [ Satellite : . . e:um}ATELLITEﬁDEV\(E,TVPE -| -l @ e ,‘ .58 r@‘ =
3 37 #pragma comment(lib,"Mobility.1ib"™) Search Solution Explorer (Ctrl+) p-
3 38 #pragma comment(lib,"PropagationModel.lib™) b Ot A
g 39 b RPL
g 48 /1106 % oot
a #define SATELLITE_LOG el R“L -
a2 void print_satellite_log(char* format, ...); [ ; 2 ]
43 void satellite log_add_tab(); V“" ,
a4 void satellite log_remove_tab(); 1 -
25 Analyze and Code Cleanup 3
46 #tdefine SATELLITE_PROPAGATION LOG =0y '
a7 Retarget Projects
48 3 typedef enum enum SATELLITE DEVICE TYPE © b
49 { Scope to This
50 SATELLITE_DEVICETYPE_USER_TERMINAL, & New Solution Explorer View
51 SATELLITE_DEVICETYPE_SATELLITE, Build Dependencies ,
52 SATELLITE_DEVICETYPE_SATELLITE_GATEWAY, i R
53 SATELLITE_DEVICETYPE_UNKNOWN, //Keep me at last .
&*  Class Wizard... Cirl+Shift+X
54 }SATELLITE_DEVICETYPE;
. & Manage NuGet Packages...
55 static const char* strSATELLITE_DEVICETYPE[] =
56 { "USER_TERMINAL","SATELLITE","SATELLITE_GATEWAY","Unknown" }; £ setas Startup Project
57 SATELLITE_DEVICETYPE SATELLITE_DEVICETYPE_FROM_STR(const char* type); Debug '
58 ¥ cut Ctrl+X
59 = typedef enum enum_linktype Paste CrleV/
N issues found Ln52  Chi42  Cok48  TABS CRIF X Remove Del
Output Rename 7]
Show output from: Build SlEls == Unload Project
1>C:\Program Files (x86)\Microsoft Visual Studio\2@13\Community\MSBuild\Microsoft\VC\v168\Microsoft.CppBuild.targets(1318,5): warning M5B8812: TargetName(Satellite) doe Load Direct Dependencies of Project
1>Satellite.obj : warning LNK4@75: ignering '/EDITANDCONTINUE' due to '/INCREMENTAL:NO' specification
1> Creating library ..\..\..\bin\bin x64\Satellite.1ib and object ..\..\..\bin\bin_x64\Satellite.exp Lead Entire Dependency Tree of Project
1>Satellite.vexproj -> C:\Users\Hanuman\Documents\NetSim_13.1.6_64_pro_default\src\Simulation\Satellite\..\..\..\bin\bin_x64\Satellite.d1l Rescan Solution
13Done building project "Satellite.vexpro: A
T w - Display Browsing Database Errors
Clear Browsing Database Errors
Error List (oY @ Open Folder in File Explorer
[J Thisitem does not support previewing K Propertics el

Rebuild Satellite Comm. Network Project

Additional Satellite Propagation log files will be available under the Log Files menu in the left

panel of the Results Window as shown below:
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Seqment Sert  Seqment Received  AckSent  Ack Racoed  Dupicas sck recohnd

o 0 [] o

o

Figure 3-10: Result Window
Users can see pathloss, fading-loss, noise, and SNR values in the Log files for each forward

and return link.

522635.7 -61.2137 -4.68242 -110.193 53.60734
655763.7 -61.2137 3.364745 -110.199 45.62068
788891.7 -61.2137 6.063285 -110.199 42.92214
922019.7 -61.2137 14.22834 -110.193 34.75708
1055148 -61.2137 -7.01998 -110.193 506.0054
1188276 -61.2137 5.611835 -110.199 43.37359
1321404 -51.2137 7.33334 -110.199 41.65188
1454532 -61.2137 10.06184 -110.193 38.92358
1587660 -61.2137 -2.02839 -110.1959 51.01381
10| 1720788 -61.2137 8.838382 -110.199 40.14704
11| 1853916 -61.2137 -2.35026 -110.199 51.33568
12| 19587044 -61.2137 7.017728 -110.199 41.96769
13| 2120172 -61.2137 B.888123 -110.199 40.0973
14 | 2253300 -61.2137 8.818%44 -110.199 40.10648
15| 2386428 -61.2137 -9.54858 -110.199 58.534
16| 2519556 -61.2137 7.889935 -110.199 41.09549
17| 2652684 -61.2137 6.853039 -110.199 42.13238
18 | 27385812 -61.2137 -4.53106 -110.193 53.51648
19| 2918540 -61.2137 -17.6974 -110.199 66.68282
20| 3052068 -61.2137 3.899016 -110.199 45.08641
21| 3185196 -61.2137 3.520567 -110.193 45.45885
Figure 3-11: Propagation log file

[f= R = R B = R B e v R
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3.9 Omitted Features

= Regenerative transponder where the signal is demodulated, decoded, re-encoded and
modulated aboard the satellite.

» |mpact of Rain/Weather on signal propagation

= Forward Error Coding in Layer 2

= |Pv6 Addressing

= No support for LEO, MEO
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4 Featured Examples

4.1 Bandwidth variation through MCS configuration

Open NetSim, Select Examples ->Satellite Communication -> Bandwidth variation
through MCS configuration then click on the tile in the middle panel to load the example as
shown in Figure 4-1.

[ Netsim Home - [} X

NetSim Standard

Network Simulation/Emulation Platform
Version 13.1.19 (64 Bit)

New Simulation
Your Work
| Examples

Experiments

License Settings

Exit

Support

Email -

Ctrl+N

Ctil+0

Alt+F4

Example Simulations

Internetworks

Cellular Networks -
Advanced Routing

Mokile Adhoc Networks
Software Defined Networks
1OT-WSN

Cagnitive Radio Netwarks
LTE and LTE-A &

VANETs

>
>
>
>
>
>
>
>
>
v Satellite Communication

QPSK.

Analyse the throughput for QPSK modulation with different coding schemes

QPSK 1/3. QPSK9/10

Satellite Properties
BER model: Fixed

BER: 0.00000001
Modulation: QPSK
Coding rate: 1/3
Configure static routes

Satellite Properties
BER model: Fixed
BER: 0.00000001
Modulation: QPSK
Coding rate: 9/10

Configure static routes

v [[Bandwidth variation through MCS configuration
QpPSK

8PSK

16APSK

160AM

32APSK

UT to UT Communication
> | GGNR

Results

Wieed Mo 5

Modulation  Coding_Rate _Throughput (Mbps)
aPsSK 3 0.084

910 0.336
8PSK . 0%
wo B b
R
T —

Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the

middle panel to load the simulation. Click on the book icon on the left (Example Si

Learn

panel to view lion (pdi).

Documentation

Contact Us

Email - sales@tetcos.com
Phone - +91 767 605 4321
‘Website : www.tetcos.co

Figure 4-1: List of scenarios for the example of Bandwidth variation through MCS configuration
The following network diagram illustrates, what the NetSim Ul displays when you open the
example configuration file as shown Figure 4-2.

¥

> ~
7 Satellite_TS
e .

# LS
//2 }\
.// \\\
4 %4
UT_Eouter_E Sat_Gatéwvay_3
I e
Ry
Router 4
-
ra 6
App1 CBR
Wired_MNode_5
i i Wired_Mode_6

Figure 4-2: Netwofk set up for studying the Bandw.idth variation through MCS configuration
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Settings done in example config file:

1. Set the following property as shown in below given table:

Satellite Properties -> Interface (Satellite) -> Physical Layer-> Forward

BER_Model
BER

Fixed
0.00000001

Table 4-1: Satellite Properties > Interface (Satellite) > Physical Layer > Forward
2. Set the following property as shown in below given table:

UT_Router Properties -> Interface (Satellite) -> DataLink Layer

Gateway Sat_Gateway_3

Table 4-2: UT_Router Properties > Interface (Satellite) > DataLink Layer
3. Go to Router_4 properties -> Network _Layer ->Enable - Static IP Route ->Configure Static

Route IP

m Router

Router

‘GENERAL
APPLICATION_LAYER

TRANSPORT_LAYER

INTERFACE_1 (WAN)

INTERFACE_2 (ETHERNET)

NETWORK_LAYER

¥ NETWORK_LAYER

Protocol IPv4
|Static_|P_Rc>ute | Enable - I
I Static_IP_Route_GUI Configure Static Route [P I

Static_IP_Route_File

ICMP_Status

Processing_Delay (Microsec)

StaticlPConfigured.ixt

| FALSE - ‘

(o |

Figure 4-3: Router Network layer properties window

4. Set the properties in Static Route IP window as per the screenshot below and click on Add.

Click on OK.
[ static IP Routing Configuration O *
Network Destination | | Gateway |
Subnet Mask | | Metrics |
Interface ID | - |
Default Add Remove
g:::::arlt(ion Subnet Mask Gateway Metrics Interface ID
11112 255.255.255.255 11311 1 1 I
OK Cancel

Figure 4-4: Configuring Static route window for router
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5. Go to Sat_Gateway_3 properties -> Network_Layer ->Enable - Static IP Route ->Configure
Static Route IP Set the properties in Static Route IP window as per the screenshot below
and click on Add. Click on OK.

[% static IP Routing Configuration O *

Network Destination |

Gateway | |

Subnet Mask | | Metrics | |

Interface ID | - |

Default Add Remove

Network
Destination

1112

Subnet Mask Gateway Metrics Interface 1D

255.255.255.255 11.21. 1 1

CK Cancel

Figure 4-5: Configuring Static route window for Sat_Gateway_3
6. Go to UT_Router_2 properties -> Network_Layer -> Enable - Static IP Route -> Configure
Static Route IP Set the properties in Static Route IP window as per the screenshot below
and click on Add. Click on OK.

[% static IP Routing Configuration O *

Network Destination |

| Gateway |

Subnet Mask |

| Metrics |

Interface ID |

Default

Add

Remave

Network
Destination
11.1.1.0

Subnet Mask Gateway Metrics Interface 1D

255.255.255.0 11112 1 1

CK Cancel

Figure 4-6: Configuring Static route window for UT_Router_2
7. CBR application source id as 6 and destination id as 5 with packet size as 1460Bytes and
Inter_Arrival_time as 467us (Generation Rate=25Mbps). Transport Protocol is set to UDP.
8. Change the Satellite Properties - Interface (Satellite) > Physical_Layer - Forward -
Modulation and respective coding rates as sshown in below Table 4-3 but for return link is
fixed Modulation-> 32APSK and Coding Rate ->3/4.

9. In NetSim GUI Plots are Enabled. Run simulation for 10 seconds and observe the result.
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Note: Satellite properties in the physical layer changes done only for the forward and Return layer

properties.

Result: Observe the application throughput as we change the modulation scheme (Satellite
Properties - Interface (Satellite) > Physical_Layer - Forward > Modulation) and respective
coding rates (Satellite Properties > Interface (Satellite) > Physical_Layer - Forward ->
Coding_Rate).

Modulation Coding_Rate = Throughput (Mbps)

OPSK g9 0336
PSK g 0507
1GAPSK g1 0677
160AM g 0675
SAPSK 0845

Table 4-3: Compare the different Modulation Scheme and Coding Rate vs. Througput

4.2 Configuring applications from UT Node to UT Node

Open NetSim, Select Examples ->Satellite Communication -> UT to UT Communication

then click on the tile in the middle panel to load the example as shown in below screenshot

[ Netsim Home - @ X

NetSim Standard
Network Simulation/Emulation Platform ﬁ
Version 13.1.19 (64 Bit)

New Simulation Ctrl+N  Example Simulations UT to UT Communication Results
Your Work Ctlso Internetworks 1. Study the packet flow between the UT nedes via Satellite and Satellite gateway.

Cellular Networks Understand how to configure static routes in the Satellite gateway and UT

" des. 5

Examples Advanced Routing nodes. 4‘;
cve Mobile Adhoc Networks - UT to UT Communieation e
xperiments

Software Defined Networks = S

CBR application
Source: UT node 2

LTE and LTE-A Destination: UT node 3
VANETs Configured static routes

Cognitive Radio Networks

>
>
>
>
>
> 10T-WSN
>
>
>
v

Satellite Communication

V' Bandwidth variation through MCS configuration
QPSK
8PSK
License Settings 16APSK
160AM
32APSK

UT to UT Communication

> 1 5GNRu

X

Exit Alt+F4

Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tile in the
middle panel to load the simulation. Click on the book icon on the left (Example I panel to view d ion (pdf).

Support Learn Documentation Contact Us
Manua Email - sales@tetcos.com
rlog; 1 Phone - +91 767 605 4321
Website 05.C0

Figure 4-7: List of scenarios for the example of UT to UT Communication
The following network diagram illustrates, what the NetSim Ul displays when you open the

example configuration file as shown Figure 4-8.
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Figure 4-8: Network set up for studying the UT-to-UT Communication
Settings done in example config file

1. Set the following property as shown in below given table:

UT_Node Properties -> Interface (Satellite) -> DataLink Layer

Gateway Sat_Gateway 4

Table 4-4: UT_Node Properties > Interface (Satellite) > DataLink Layer
2. Go to UT_Node_2 properties -> Network _Layer -> Enable - Static IP Route ->Configure
Static Route IP.

[ satellite_Ut

x
Satellite_Ut ¥ METWORK_LAYER
GENERAL Protocol IPv4
Static_IP_Route Enable

APPLICATION_LAYER

TRANSPORT_LAYER

Static_IP_Route_GUI

Configure Static Route IP

Static_IP_Route_File StaticlPConfigure2.txt

NETWORK_LAYER

Processing_Delay (Microsec) | 0.0 ‘

INTERFACE_1 (SATELLITE)

Figure 4-9: Network layer properties window for UT_Node_2

3. Set the properties in Static Route IP window as per the screenshot below and click on Add.
Click on OK.
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m Static IP Routing Configuration O
Metwork Destination | ‘ Gateway |
Subnet Mask | ‘ Metrics |
Interface ID | A |

Default Add Remaove
::::::arlt(ion Subnet Mask Gateway Metrics Interface 1D
11.1.1.3 255.255.255.255 11111 1 1

0K Cancel

Figure 4-10: Configure static route for UT_Node 2

4. Goto Sat_Gateway_4 properties -> Network_Layer -> Enable - Static IP Route ->Configure

Static Route IP

[¥ satellite_ Gw
Satellite_Gw
GENERAL
APPLICATION_LAYER
TRANSPORT_LAYER

NETWORK_LAYER

INTERFACE_1 (SATELLITE)

¥ NETWORK_LAYER

Protocol

IPv4

IStatic_I P Route

| Enable

IStatic_I P_Route_GUI

Configure Static Route IP

Static_|P_Route_File

Processing_Delay (Microsec)

StaticlPConfigured.txt

‘ 0.0

Figure 4-11: Network layer properties window for Sat_Gateway 4

Click on OK.
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. Set the properties in Static Route IP window as per the screenshot below and click on Add.




EE- Static IP Routing Configuration

O *
Metwork Destination ‘ ‘ Gateway ‘
Subnet Mask ‘ ‘ Metrics | ‘
Interface ID | - |
Default Add Remave
NE“?D rk. Subnet Mask Gateway Metrics Interface 1D
Destination
11.1.1.0 2552552550 11.1.1.3 1 1
QK Cancel

Figure 4-12: Configure static route for Satellite_Gateway 4

6. Set Application Properties are default (Packet Size: 1460, Inter Arrival Time: 20000 us)

7. Set Transport Protocol to UDP

8. Enable Packet Trace, Event Trace and Plots.

9. Run simulation for 100 seconds and observe the result.

Result: Go to the result window and open packet trace/ Animation window user can observe
the packet flow from UT node (source) - Satellite > Sat gateway - Satellite > UT node

TRANSMITTER IO

(destination)
a g . 4
L e
4 a0
A1TN
/ \
/ ‘ ‘ \'\
(R
4
f s iy ' \
.’f \
PM.l:MJD H-WI_NLID PMI'LI_“"I DET-IMTW}.I_I.D
Figure 4-13: Animation Window
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PACKET ID|-¥ SEGMENT ID|~ | PACKET TYPE[~|CONTROL PACKET TYPE/APP NAME|~|SOURCE ID|~|DESTINATION ID|~ |TRANSMITTER ID[~|RECEIVER ID [~ ]

1 0 CBR Appl CBR SATELLITE_UT- SATELLITE_UT-3 SATELLITE_UT-2 SATELLITE-1

1 0|CBR Appl CBR SATELLITE_UT-|SATELLITE_UT-3 SATELLITE-1 SATELLITE_GW-4
1 0 CBR Appl CBR SATELLITE_UT- SATELLITE_UT-3 SATELLITE_GW-4 SATELLITE-1

1 0|CBR Appl CBR SATELLITE_UT-|SATELLITE_UT-3 SATELLITE-1 SATELLITE UT-3

Figure 4-14: Packet Trace
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